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1. CREEP ANALYSIS

This chapter contains examples of creep analysis using the program ATENA. Currently the
commands required for creep analysis are not supported by the native ATENA graphical
environment, and therefore the necessary commands must be entered manually or by using the
ATENA-GID interface. GID (see the Internet address http:/gid.cimne.upc.es/) is a general
purpose finite element pre and post-processor that can be used for data preparation for ATENA.
See the README.TXT file in the ATENA installation for the instructions how to install the
ATENA interface to GID.

In order to activate the creep analysis option an appropriate problem type must be selected: Data |
Problem type | AtenaV4 | Creep.

1.1 Long term deflection of a reinforced concrete beam.
Keywords:  reinforced concrete, discrete reinforcement, creep

Input files: EXAMPLES\GID\CREEP2D\VITEK2D.GID,

EXAMPLES\GID\CREEP3D\VITEK3D.GID

1.1.1 Introduction

This example demonstrates the application of ATENA system to the creep analysis of a
reinforced concrete beam. The analyzed beam was tested by Dr. Jan Vitek from
Metrostav corp., Czech Republic.

1.1.2 Comments on FE model preparation

General data

The problem is modeled by two models: two-dimensional one and three-
dimensional. In both cases the geometrical model (Figure 2 and Figure 4) is created in
such a way to facilitate the generation of purely structural meshes, i.e. meshes that are
composed of only quadrilateral and hexahedral elements in 2D and 3D respectively.

1.1.2.1 Reinforcement

If program GID is used for pre-processing, the reinforcement can be modeled in two ways:
smeared reinforcement can be modeled by Reinforced Concrete material or by discrete bars.
Discrete reinforcement bars are modeled as line curves. These lines should be meshed by as few
elements as possible. Typically one truss element per line is sufficient. ATENA then automatically
determines the intersection of these lines with the 3D model and places reinforcement embedded
elements into each segment that is created by this process.


http://gid.cimne.upc.es/�

1.1.2.2 Materials

When creep analysis is requested, the material for which creep should be taken into account
must be modeled by one of the creep materials (see the Atena Theory Manual [1] or Atena Input
File Format [2]). Within the creep material a base concrete material is defined, which is one of
the standart ATENA materials. Currently only following materials are supported as creep base
materials: “CC3DNonLinCementitious2”, “CC3DbilLinearSteelVonMises” or
“CC3DDruckerPragerPlasticity”.

Material properties used in this example are listed in Table 1.1-1 and Table 1.1-2.

1.1.2.3 Topology and loading

The loading history is defined in terms of intervals in GID. In the first interval the supports are
defined as well as the two vertical forces. The first interval should represent the application of the
permanent load. In the subsequent interval this load will be kept constant and the material will creep
causing the deflections as well as cracking increase. The application of the permanent load is expected
to cause some cracking, therefore it is subdivided in 20 steps. The application of the permanent load
will start at the time of 63 days and it will be completed at 63.02 days.

In the second interval, no additional forces are applied, therefore only supports are defined for this
interval. The interval starts at 63.02 days and continues up to the stop time (i.e. 365 days) defined in
Data | Problem Data. This interval is represented in ATENA by only a single step. ATENA
automatically inserts substeps, if it determines that one load step would not be sufficient for such a
long time period.

Monitoring points

Monitoring points are chosen in order to describe a load-displacement response as well as the long
term behavior. In ATENA-GID interface the monitoring is defined as conditions (Data |
Conditions). The monitoring defined in this way is considered only if specified in the first interval.
The definition of monitoring points in subsequent intervals is ignored. In this example always the
applied force is monitored as well as the mid-span deflection.

Run

Analysis can be started either directly from GID or by typing the following command:

%AtenaWin% /M CCStructuresCreep

It is important to specify the /M option in the command line when invoking the AtenaWin program.
This activates the creep module and various creep commands. If the /M option is not used various
syntax messages are obtained.



1.1.3 Results

The results from the analysis are documented in Figure 6, where the calculated long term mid-
span deflection is compared with the experimental data obtained by Dr. Vitek. It shows that
without any specific calibration, the model predicts well the long term deflections.

1.1.4 References

[1] Atena Documentation, Part 1, Atena Theory Manual, Cervenka Consulting 2003.

[2] Atena Documentation, Part 6, Atena Input File Format, Cervenka Consulting 2003.

[3] Atena Documentation, Part 8, User’s Manual for ATENA-GID Interface, Cervenka Consulting

2003.
Table 1.1-1 Material properties of concrete
Material type Creep material: CCModelB3
Concrete type 1
Thickness, ie. ratio of volume [m’] to 0.05138
surface area [m’] of cross section
Cylindrical ~ compressive  strength| 46.75
after 28 days [MPa]
Elastic modulus after 28 days [GPa] E® 34,2
Humidity [-] 0.6
Density [kg/m’] P 2370 kg
Aggregate/cement ratio [-] AC 4.44
Water/cement ratio [-] WC 0.5
Shape factor [-] 1.0
Curing [-] Air
End of curing [days] 7
Base material:
CC3DNonLinCementitious2
Elastic modulus [GPa] E. 34 200 MPa
Poisson’s ratio - v 0.2
Compressive strength [MPa] f. 46.75
Tensile strength [MPa] f; 3.257




Fracture energy [N/m] Gy 127
Compressive plast. def. [m] Wy -0,0005
Table1.1-2 Material properties of reinforcement

Material type Reinforcement
bilinear
Elastic modulus E 210 | GPa
Yield strength oy 400 | MPa
Hardening perfectly plastic
Table 1.1-3 Finite element mesh
Finite element type CClIsoQuad CClsoBrick
— Quadrilateral, - Hexahedral
isoparametric isoparametric
Element shape smoothing N/A N/A
Optimization Gibbs-Poole Gibbs-Poole

Table 1.1-4

Solution parameters

Solution method

Newton-Raphson

Stiffness/update

Tangent/each iteration

Number of iterations 60
Error tolerance 0.01/0.0001/0.01/0.01
Line search off

Prosty nosnik AaB

Pohled
1.35

108y 1.35

!

i35

0.2

0.2

3.9

Pricny fez

0.14

Vyztuz 4 x¢ 10 mm 10505 R
Kryti 30 mm

Zatizeni - F= 6.9kN

Figure 1: Geometry of the reinforced concrete heam.
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Figure 2: Two dimensional geometrical model with reinforcement, loading and boundary conditions in GID.

Figure 3: Two-dimensional finite element model.

Figure 4: Three-dimensional geometrical model with reinforcement, loading and boundary conditions in GID.

Figure 5: Three-dimensional finite element model.
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Figure 6: Long-term mid-span deflection. Comparison of two- and three-dimensional analysis with experimental data.

2. STATIC ANALYSIS

This chapter contains examples of static analysis using the program ATENA. Currently some
commands required for static analysis are not supported by the native ATENA graphical
environment, and therefore the necessary commands must be entered manually or by using the
ATENA-GID interface. GID (see the Internet address http:/gid.cimne.upc.es/) is a general
purpose finite element pre and post-processor that can be used for data preparation for ATENA.
See the README.TXT file in the ATENA installation for the instructions how to install the
ATENA interface to GID.

In order to activate the creep analysis option an appropriate problem type must be selected: Data |
Problem type | AtenaV4 | Static.

2.1 Example of a static analysis with reinforcement

In this example we demonstrate the usage of GiD for data generation of a simple structure. The
structure is a reinforced concrete L-shaped cantilever. It has fixed supports on one end and is
loaded by vertical force near the free end. See Figure 7. The first beam adjacent to the fixed end
is subjected to a simultaneous action of bending and torsion while the second beam, is only
under bending. A complex three-dimensional behaviour can be well analysed by ATENA, and
for this purpose, the input data can be prepared in GiD.

2.1.1 Reinforcement modelling

The longitudinal reinforcement is by bars 4@328 that are located long the edges, and by stirrups
@12 with spacing 100mm in the first beam, (section A) and with spacing 200mm in the second
beam (section B).


http://gid.cimne.upc.es/�
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Since there are different possibilities to model reinforced concrete we make first a decision
about the modelling approach. Concrete shall be modelled by 3D brick elements. For this we
chose the hexahedra elements. The longitudinal reinforcement shall be modelled by discrete
bars. The stirrups shall be modelled as a smeared reinforcement within the reinforced concrete
composite material. This is a simplified method, by which we avoid an input of detail geometry
of stirrups. In smeared model the exact position of individual stirrups is not captured, and only
their average effect is taken into account.

The resulting model is shown in Figure 8. The colours of elements show two types of materials
used: the composite material named Cantileverl in the short beam and Cantilever2 in the longer
beam. The discrete bars are modelled by linear elements as shown in Figure 9. In the following,
we shall treat the generation of the model in more details. A data file with this example can be
found in the ATENA installation under the name
SmallCantileverWithTorsion_DiscreteBars.gidTutorial.Static3D in the subdirectory \Atena
Examples\ Tutorial.Static3D\.

4\00 A P Section A Section B

1—2512 1-52)’12
200

=28 228

600

Figure 7: L-shaped cantilever beam. Dimensions in mm.

[ Cantileveri
[ Cantilever2
Hl Hain_Reinf

Figure 8: The model with two composite materials: Cantilever 1 and Cantilever 2.
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Figure 9: The model of the discrete bars.

Since the smeared model of stirrups does not exactly represent their geometry it is alternatively
possible to use discrete bars as well. This is case is not described in this manual, but it can be
found in the data file Demo_ L Bars.gid enclosed in the ATENA installation.
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Figure 10: Final finite element model with supports and loading.

2.1.2 Problem type and data

Typically, the problem definition starts by choosing an appropriate problem type by selecting
the menu item ‘Data | Problem type | Atena V4 | Static’ and then the general solution data in

‘Data | Problem Data’. Both steps were already described in Chapter 4. However, the
parameters of ‘Problem Data’ can be also changed later.
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2.1.3 Geometry

The geometry is created by using the GiD graphical tools from elementary objects
sequentially, starting from points, lines and finally surfaces and volumes. We start
with the definition of points. Points are connected to lines. From lines we can form
surfaces and from surfaces we can form volumes (solid objects). Details of this
input shall be skipped, since it belongs to standard GiD functions. The final
geometrical model is shown in Figure 11. Note that it contains two types of
objects: volumes for concrete (and reinforced concrete) and lines for the discrete
reinforcement.

In GiD, it is also possible to create volumes directly from predefined primitives as
shown in the figure on the right, which indicates the available list of predefined
primitives such as rectangle, circle, sphere, etc. The volumes can be also created by
extrusion, which is activated from the GiD menu Utilities | Move or Copy. In this
dialog various copy operations can be selected such as: rotation, translation, sweep.
There is also a check box, which activates the extrusion.

Figure 11: Geometrical model.

A

2 BN & B4
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2.1.4 Materials

The materials can be defined and assigned to the geometry using the menu item ‘Data |
Materials‘. Recommended procedure is to keep the default material unchanged for later
reference and create any number of user-defined materials. Since we intend to model the
vertical stirrups by smeared reinforcement we shall use the material type ‘Reinforced concrete’.
CCCombinedMaterial is a default material and Cantileverl, Cantilever2 are user-defined

composite materials that are created from the default material by pressing the button @ This
command creates a new material of the same type, which can be assigned a suitable user-
defined name (see Figure 12).

s

s Reinforced Concrete

Cartileverl - @ O % a2 @

Basic ] Concrete Comp 0 ] CCSmearedReinf 01 ] CCSmearedReinf 02 ] Element Geomety ]

Matenial Protatype CCCombinedk aterial
-
[w Activate SmearedReinf 01

[V Activate SmearedR einf 02 The
[ Activate SmearedReinf 03

smeared reinforcement
components are activated using
these checkboxes. When
Assigh Draw Unassign Exchange Selected, new property sheets
appear in the dialog

Cloze

Figure 12: Reinforced concrete material. Two composite materials created.

2.1.4.1 Reinforced concrete as composite material

First we define parameters of concrete component. This can be done by selecting the tab
‘Concrete Component(0)’ and modifying its parameters. There are several choices available for
the basic material. It is recommended to select the material CC3DNonLinCementitious2, which
is identical to the same material from the group ‘Concrete’. The dialog window is extended to

allow additional reinforcement components. The buttons @l&lﬁ allow changing, adding

c
new and deleting of materials. When adding a new material with the button QT the default
material is first copied, then re-named and edited.

The stirrups are modelled by smeared reinforcement as Component(1l) of the composite
material. The first 5 parameters describe the initial elastic modulus, reinforcing ratio and
direction.

The reinforcing ratio of smeared reinforcement is calculated as p=A,/A4., where 4, A. are the
section areas of bars and concrete, respectively, in the considered volume. This ratio is different
in each part of cantilever due to different stirrup spacing. The direction of the smeared
reinforcement is defined as a unit vector.

The constitutive law of the reinforcement is defined as multi-linear by a sequence of points
(stress-strain pairs). The first point is defined by yield strength (and elastic modulus). This gives
a bi-linear, elastic-plastic law, with unlimited ductility. A general multi-linear function can be
defined by additional points. Maximum 4 additional points can by given.

Up to three smeared reinforcements can be defined in one composite material. This limit exists
only in the GiD interface. (ATENA can define unlimited number of components for a single
composite material, in this case it is necessary to manually edit the ATENA input, which is
generated by GiD.)

After the parameter definition, the material can be assigned to the structure. This is done by the
button ‘Assign’ and following the appropriate selection by mouse. The process of selection is a
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general operation, and it allows for selecting of points, lines, surfaces and volumes. In this case,
the material should be assigned to volumes (of geometry), Figure 15, Figure 16.

Reinforced Concrete

Cantlever] - EOK

Basic Conctele Comp 1 | CCSmearedReinf 01 | CCSmeaisdRsint 02 | Element Gisomsiry |

h?

Base Material Frototype  CC3DNonLinCementitious2  —!

Young 5 ModulusE: |3 4E+4 MPa

Puoizson & Ratio-MLU ’UZ—
Tension shength-FT: (2,18 MPa
Compresion strength-FC: |-34.0 MPa
Fracture energy-GF: |7.018e5 %
Fieed Crack[07
¥ Activate Crack spacing
Crack spacing:[02 ~ m

Iv Activate Tensian stiffening

Tension stitfening | 0.4

Plastic stainEPS CF |-0.0003388
Onset of crushing FCO:|-7.0 MPa

Critical comp disp-w/D: |-0.0005 m
Excentricity-ExC 0,52
Dir of pl flow-BETA 0.0

MM

RHO Density: |0.023 =
m
Thermal Expansion-Alpha|0.000012

Assign Draw Unassign Exchange

Close

Figure 13: Conarete component in the ‘Reinforced concrete’ material

Reinforced Concrete
Cantiever] - BOX X2 )

Basic | Concrete Comp 0 | CCSmearedReint 01 CCSmearedReint 02 | Elament Geomety |

Reinf 02 Material Pratatype CCSmeared einf

Reinf 02 Young s Modulus-E: [2.1E+5 MPa

Fieinf 02 Reinforcing RATIO p=As/4c |0.002%

Reinf D20t % of the smeared reinf[0 oy
Fleinf 02 Dir Y of the smeared reinf[1
Fleinf 02 D Z of the smeared reinf [0
Fieinf 02 Yield Strength v5: [400 o
Reinf 02 Number of Multlinear values 2 — ] H
Reinf02eps2[02 T '
Renf02f2[400  MPa i, q 2 i
Reinf02eps3[0 L e T ' i
Renf0ziz[l  MPa i ' ' ]
Reinf 2epsdD . : : !
Renf020 MPa : ! !
Reinf02epssl0 : 3 E ;
Reinf 02 (5:[0 MPa O i & P 5 F

N
Reinf 02 RHO Density: |0.0785 3
W
Fieinf 02 Thermal Expansion-Alpha | 0.000012

Assign Draw Unassign Exchange

Clase

Figure 14: Components of smeared reinforcement in the composite material




16

Material Prototype  CCCombinedt aterial
=3

¥ Activate SmearedReinf 01
¥ Activate SmearedReinf 02
[~ Activate SmearedReinf 03

Cartilewverl hd @ O x

Basic ] Concrete Comp 0 ] CCSmearedReinf 01 ] CCSmearedReinf 02 ] Element Geametry ]

k‘?

Azsign

Faints
Lines

Surfaces

Draw Unassign

Lloze

Exchange

Figure 15: Menu item ‘Assign | Volumes'.

Figure 16: Selected volumes are highlighted by red colour.



Reinforced Concrete

ez B0 KD

Basic | Concrete Comp 0 CCSmesredReint 01 ] CCSmeatedRieint 02 | Element Geametry |

Reinf 0 haterial Prototppe CCSmearedReint

Reinf 01 Young s Modulus-E: W MPa
Feinf 01 Reinforcing RATIO p=asfac[00dia
Feinf 01 Dir’¥ of the smeared reif[0 G5
Fieinf 01 Dir'Y of the smeared reimflﬂi
Feinf 01 Dir £ of the smeared raimfhi

Reinf 01 Yield Strength vS: [400 MPa
Fieinf 01 Mumber of Multiinear values 2 —1

Feinfll eps2iz
Reinf01f2[400  MPa

Feinf0l eps3ll
Reinf01f:[0 MPa

Feinf0l epsdl
Reinf01f4:[0 MPa

Feinf0l epsS0

Reinf 01 15: [0 MPa

MN
Reinf 01 RHO Density: |0.0785 =]
m

Reinf 01 Thermal Expansion-lpha|0.000012

Agsign Diraw Unassign Exchange

Close

Figure 17: Assignment of the material ‘Cantilever2’
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D cantilever1
B Cantilever2

Figure 18: Display of the assigned material groups

A composite material for the second part of the structure (named as Cantilever2) can be defined
in a similar way, where the only difference is in the value of reinforcement ratio, Figure 17.

2.1.4.2 Bar reinforcement

From the menu ‘Data | Materials® we select the material ‘Reinforcement’, which is designated
for discrete bars. There we choose from the list the ATENA-model ‘CCReinforcement’ and
then click on the button ‘New reinforcement’ and enter the name for the reinforcement material.
After confirmation by OK a dialog for material parameters appears. The parameters include
initial elastic modulus, yield strength and optionally points on the stress-strain curve. The last
parameter is the bar cross-sectional area (see Figure 20).

The material is then assigned to the geometry by pressing the button ‘Assign‘ and selecting
‘line* geometric entities by the mouse. The selected bars are marked by red color, Figure 21.
Applying the command ‘Draw’ at the bottom of reinforcement material dialog (see Figure 22)
can check a correct assignment, which shows the geometry (in this case lines) with the currently
assigned material.

In case of pre-stressed bars each bar (cable) must have a distinct material (even if its values are
identical with other bars). The reason for this is to distinguish among groups of elements for
pre-stressing. The pre-stressing is defined in ‘Conditions | Lines | Initial strains’ and is assigned
to the lines that model the pre-stressing reinforcement.
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Figure 19: New material for bar reinforcement.
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Figure 20: Material parameters for the ,Reinforcement’ model
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% Reinforcement

CC1DElastsotopic - @ O x a2 3

Basic ] Mizcelaneous ] Element Geometry 1

Material Protatype CC1DElastsotiopic z
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Poisson & Ratio-tU 0.3

™ Calculator

RO To recalculate click Update
changes next to material box 24, please

ez [0000201061  m2

Assign Unassign Exchange

tlzotiopic

A,
Figure 22: Display of the reinforcement material assignment
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2.1.5 Supports and loading

The supports and loading can be a specified using the menu ‘Data | Conditions’. We define the
fixed nodes by checking X-, Y-, Z-Constrains and the type of geometry ‘Surface’. Using the
command ‘Assign’ we selects the end face of the cantilever and finish the assignment of support
conditions.

In a similar way we assign the Point-displacement at the node of load application. The load is
applied as a vertical imposed displacement. Consequently the force value is a reaction at this
node.

s Conditions

2 N\ R

Constraint for Surface A n? @

B asic: ]

Coordinate Systenn GLOBAL ——4
v x-Consztraint
I *v-Constraint
v Z-Constraint

Agzzign Entities Draw Unaszign

Close

Figure 23: Definition of the surface supportin all directions

T Conditions

a N SUH

Displacement for Paint - k2 @
USE decimal point! (00 HOT uze comma)

—

¥-Dizplacement: [0.0 m
-Digplacement; (0.0 m
Z-Dizplacement: | {00005 m

Azzign Entitiez Ciraw Unaszign

LCloze

Figure 24: Definition of prescribed displacement in vertical direction

The conditions dialog of GiD can be also used to define ATENA monitors. These are special
type of conditions that does not affect the analysis results. They are merely used to monitor
certain quantities during the analysis. In this example, the following monitors will be specified:

e Maximal crack width
e Displacement at the point of load application

e Reaction at the point of load application

The definition process of the above conditions and monitors is described in Figure 26. The
resulting assignment of the boundary conditions can be checked using the command Draw | All
Conditions | Exclude local axis, which can be located at the bottom of the Conditions dialog. It
should be noted that it is also possible to apply these conditions directly on the generated finite
element model, but then the applied conditions are lost every time the mesh is regenerated.
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Figure 25: Definition of the ATENA monitors
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Figure 26: Display of assigned conditions

In certain cases it may be advisable to manually identify which line entities represent
reinforcement. By default the GiD-ATENA interface attempts to treat all lines that are not
connected to any surface or volume as reinforcement. This default behavior is activated by the
corresponding check box in the Problem Data dialog. In certain cases the automatic
identification does not work properly. In this case it is advisable to deactivate this default
behavior, un-assign all reinforcement node and element identification and then assign it again

manually.

T Conditions

» NS

Reinforcement Hodes |dentification

Displacement for Line
eight far Reinf Line
Temperature for Reinf Line
Initial Strain for Reinf Line

Reinforcement Hodes |dentification
Reinfarcement Elems [dentificatian

Azzign Entities Diraw

Cloze

These two conditions should be
manually assigned to all
reinforcement line entities, if
-@ error messages about
reinforcement identification
appear during mesh generation
or during the generation of the
ATENA input file.

Prior to that the automatic
reinforcement identification
check box should be
deselected and all
reinforcement identif.
Conditions unassigned

Unazzigh

Figure 27: Manual identification of reinforcement nodel
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2.1.6 Meshing
In the preceding description the geometry was defined and all properties (material, supports,
loading) were assigned to geometry. Now we shall generate a finite element mesh.
For this we must set up appropriate parameters in the menu ‘Meshing’,
Meszhing
' [uadratic elements 4 v [Momal
I Aszign unstiuct. sizes L4 [uadratic
Structured g [uadraticd
3
3

Meszh criteria

Element type

Boundanies

Liraw sizes L4

Reszet mesh data

LCancel mezh

Generate. .. Ctrl-g
Mezh view Ctrl-m
tezh quality...

Edit mezh L4

Figure 28: Meshing menu.

2.1.6.1 Mesh definition for volumes (concrete)

First we shall deal with the meshing of volumes (concrete). There are many ways how to define
mesh. In this case, we use a simple method, in which divisions on all lines are defined. If
opposite lines have the same division we can create a regular mesh.

e In the item ‘Quadratic elements’ we define low order elements by checking ‘Normal’.

e In ‘Structured’ we define division on all lines. It is always sufficient to select one line.
GiD automatically assigns the same division to all opposite edges.

e In ‘Mesh criteria’ we select lines.

e In ‘Element types’ select ‘Hexahedra’.

2.1.6.2 Mesh definition for lines (reinforcement)

It is important to realize, that lines of reinforcement in GiD serve only to export geometry to
ATENA. The embedded reinforcement will be generated in ATENA. This means that we should
make the line elements of reinforcement as large as possible. If we use division into a single
element then this single element is then passed to ATENA for the generation of the individual
bar segments. Finding the intersections of the reinforcement bar with the solid elements
generates the segments. In case, the reinforcement in GiD is modelled using curved lines, then it
is recommended to prescribe a certain division to finite elements such that the curved geometry
of the bar is properly represented.
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§il Enter value window x|

Enter number of cells to assign to lines

1

4| [ »
Ik Cancel

Figure 29: One division in lines of reinforcement.

- In the item ‘Quadratic elements’ we define low order elements by checking ‘Normal’.
- In “Structured’ define 1 division on lines, Figure 29
- In “‘Mesh criteria’ select lines.

- In ‘Element types’ select ‘Linear | Lines ’.

2.1.6.3 Mesh generation

By selecting the item ‘Generate...” the mesh is automatically generated. The mesh can be
inspected in the items ‘Mesh view’, ‘Mesh quality’. To change the mesh the whole process can
be repeated. GiD allows also changes by editing the mesh dimensions and properties.

2.1.6.4 Assign conditions to mesh nodes

Now, if needed it is possible to assign additional conditions or materials directly to finite
elements of nodes. Select ‘Data | Conditions’ as shown in Figure 30. For this we must select by
mouse the node, where condition should be applied. It is however, recommended to assign the
material properties and boundary conditions on the geometric entities rather then on the mesh,
otherwise it is necessary to reassign such properties every time the mesh is regenerated.

il Conditions ]

PRNEE

|Print-Displacement g @
#-Displacernent IEIEIi

-Digplacement 0.0
Z-Displacement [-0.001]

Azsign | Entitiez | Draw | Unaszsign

Figure 30: Assigning condition of point-displacement to a mesh node.
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Figure 31: View and inspect a conditionin a mesh node.

If we want to inspect the assigned values, we can do it by clicking on the button ‘Draw’ and
select ‘Field value | Z-Displacement’. Then the assigned condition value appears at the
concerned node. See Figure 31.

2.1.7 Monitoring points

Analogically to the Section 2.1.5 it is also possible to specify the monitoring points directly on
the finite element mesh. The monitoring points are tools to record a structural response, for
example a load-displacement diagram. In GiD we can for instance specify only force and
displacement monitoring at a mesh node. This is done also in ‘Conditions’. For applied force we
select ‘Force-Monitor’, for reaction force ‘Reaction-Monitor’, for nodal displacement
‘Displacement-Monitor’. Displacement component is selected by checking the appropriate box.

il conditions X
]

N
honitor for Paint j L

OutputData  REACTIONS ‘
[T Dir-¥
I Diry
I Dir-2

I Draw Each lteration

Flnlsh Fress 'Finish' to end selection

Qlusel

Figure 32: Definition of a monitor for reaction at node.
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bill conditions

I ,|“<§ |

konitor for Paoint j

x|

WY 4%

Output Data. DISPLACEMENTS _l|

™ Dir-x
I~ Diry
F Dir-Z

[T Draw Each teration

¢ Finish {Press Finizh' to end selection

Figure 33: Definition of monitor for displacement at node.

Figure 32 and Figure 33 show definition of force (reaction) and displacement monitors at a
node. An inspection of monitors can be done by the command ‘Draw’ in the same manner as in

other conditions.

The monitoring points must be included within ‘Conditions’ of the first load interval in GiD.

Monitors included in other intervals will not be active in ATENA analysis.

2.1.8 Load history
For analysis in ATENA a load history as a sequence of load steps must be defined. The load
steps can be proportional or non-proportional. In this example the load history is simple. We
define first interval, which includes a set of conditions for supports at the fixed end and point-
displacement. This can be checked and changed in the menu item ‘Data | Interval Data’. Next
load steps can be done in two ways. The simplest way is to enter the number of repeated load
steps and multipliers in the window of ‘Interval Data’, Figure 34, which is a proportional load
history. In case of a non-proportional history, for example, first a vertical load followed by a
horizontal load, we can use ‘Data | Interval Data’. Default settings of calculation method and
global settings are in ‘Data | Problem Data’.
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W Interval Data 4 | All conditions will be multiplied by a factor
[ - ) 1.0 in all load steps generated in this interval
LOAD NAME [Load ...
LOAD STEP Multiplier 1.0 T Results from all steps will be saved. Each step
Store data far thiz IntervalSteps SANVE ALL —

is saved in a separate file, which is named

I Generate Multiple Steps TaskName.xxx, where xxx denotes the step

Mumber of LOAD STEPs |50 number
-
\ ' '
INTERVALSTARTING TME@D | cay 50 load s(tie.::?s will be generated. All with the
same conditions
INTERVAL END TIME: [0.04 day \
50 . .
- . " | These data fields are editable only the import
ser Solution Parameters . .
of transport data is requested in Problem Data
Close dialog

Figure 34: Interval data definition

2.1.9 Analysis and post-processing

The non-linear analysis is started by the menu item ‘Calculate‘ or icon E This causes the
data from GiD to be written into an input file for ATENA (*.INP) and the program AtenaWin is
started.

During the execution of AtenaWin variety of intermediate results can be viewed and inspected.
The results of analysis can be presented in the program Atena3D. The Post-processing in
ATENA 3D is started via menu ATENA | ATENA 3D post-processing. Then it is necessary to
import the binary result files (TaskName.xxx) from the required load steps into ATENA 3D.
This is accomplished through the ATENA 3D menu File | Open other | Results by step.

For operation of AtenaWin, Atena3D or any other details of ATENA software see the ATENA
Documentation.
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2.2 Tutorial for Construction Process

2.2.1 Introduction

The objective of this tutorial is to show how the graphical environment of GID can be
used to model the construction process. The finite element solution core of ATENA
supports the possibility to add or remove groups of finite elements. This feature can be
used to model the construction process in GID. The ATENA-GiD extension of the GID
graphical environment includes direct support for this feature. This feature can be
modeled using the conditions for surface and it will be demonstrated in this manual on
the example of a tunnel (see Figure 35:).

| N

Soil

Soil / Lining

Soil / Air

Figure 35: Model with three macro-elements.

The basic idea of the construction process modeling in ATENA is the following. It is possible to
add or remove finite element groups at any time.
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2.2.2 Geometry, boundary conditions and load
We need to analyze a structure of a tunnel. Around the tunnel there is concrete lining. Boundary
conditions are seen in Figure 36.

klonitor for Point

W Conditions

@ N S

Constraint for Point

Basic }

v X-Constraint
W Y-Constraint
™ Z-Constraint

Coordinate System  GLOBAL —!

Assign

Enlities

LDiraw

Corstraint for Point

Colors

All conditions:
Figld's walug
Field's colar

Unassign

E rclude local axes
Only local axes
Include local axes

Dead Load

1

Monitor points

nitor for Point

Constraint

. 1 .

Figure 36: Draw all conditons on model

The construction should proceed as follows:
1. excavation of a circular hole in the soil
2. adding lining (ring)

3. adding load
First, it is necessary to construct the model of the whole structure. Three separate
macro-elements will be created for all four intervals.

Interval 1: this interval is used to define the basic boundary conditions to support the model
from the bottom and both sides.

Interval 2: this interval is used for excavation of a circular hole in the soil by deleting
two centered macroelements.

Interval 3: this interval is used to add lininig (ring shape) with concrete material characteric
around the hole.

Interval 4: this interval is used to add load to top face of the model.

At the beginning, the whole area consists of soil, however, we must define separate
macroelements for future changes (soil, lining, air). We assign the soil material to all these
macroelements for the first interval (Figure 37:). The additional intervals will be needed for the
subsequent phases of the construction process.
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[E CC3DDruckerPragerPlasticity]

Figure 37: Material for interval 1

In next step (excavation) we need to remove both circles from the center. It can be made using
conditions for surface. In menu “Data > Interval > Current” we switch to interval No.2 which
we want to edit (Figure 38: ). In menu “Data > Conditions > Conditions for surface” we
choose “Elements Activity for Surface” and select ,,Construction (Elements Activity) :
DELETE” (Figure 39). Next we can “Assign” areas which we want to excavate (Figure 40).
We can draw all macroelements which have assigned some conditions by choosing “Draw >
Colors” (Figure 40).

b

i Enter value window

Figure 38: Switching current interval.
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a ™ 1
Elernents Activity for Surface - k2
|L|sing for Conztruction State for 200 Geometry except Shell|
Construction[Elements Activity] DELETE —
H Aszsign Entitie=s Diraw nassign
LCloze

Figure 39: Conditions for surfaces

W Conditions
LR
'Elements Activity for Surface - N2 @
|Usmg for Construchion State for 20 Geomety except Shel\l
Conztruction(Elements Activity] DELETE —
Aazsign Entities Draw Unassign
o Elements Activity for Surface
All conditions 4
Field's walue 4
Field's color 4

@ DELETE CC3DMonLinC
ementitious? E
32000 MU 8.2 8

Figure 40: Deleting materials in interval 2

In the next step, we need to create the lining with non-linear concrete material. We switch the
current interval to No.3. In menu “Data > Conditions > Conditions for surface” we choose
“Elements Activity for Surface“ and select ,,Construction (Elements Activity): CREATE
WITH NEW MAT?” (Figure 41), and choose the CC3DNonLinCementitious2 material. We can
create specific material for this case and assign to surfaces, which we want to create (Figure 42).
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o ™\ A

Elements Activity for Surface - h_ @
IJzing for Construction State for 30 Geometries without S hell =

Construction(E lements Activity] CREATE WITH MEW MAT —

Agzzign material material for linning —

Azsign Entities Drraw Unasgzign

Cloze

Figure 41: Condition for surface, create new material

E CREATE_WITH_HEW HA
T CC3DMonLinCement
itious2 E 34208

Figure 42: Creating concerete lining.

In the Ilast step (Interval No.4), we will only add load to top of the model
(“Data > Conditions > Conditions for line”, “Load for line™).

2.2.3 Running analysis
Analysis can be run by selecting button in menu “Calculate > Calculate” or clicking on the

button . “Atena Calculate” and in Atena Win by clicking on button == “Execute®.
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3. TRANSPORT ANALYSIS

3.1 Tutorial for Thermal Analysis
An example demonstrating the coupling of thermal and stress analyses.

3.1.1 Introduction

This document describes an example of rotationally symmetrical vessel subjected to
thermal loading. The analysis is performed using the programs ATENA and GiD.
ATENA is used for thermal and static analysis and the program GiD is used for data
preparation and mesh generation.

The programs GiD and ATENA can be installed using the standard ATENA
installation. At the end of the installation the user must select the installation of GiD and
ATENA-GID interface. After that your computer should be ready to run the example
problem described in this document.

3.1.2 Thermal Analysis

First the program GiD is started. The recommended version is 9.0.4 or newer (the oldest
supported version is 7.7.2b). After starting GiD, the user should open the example
analysis "ATENA Science\ATENA-GiD\Tutorial. Temperature2D\PipeBTemp.gid".
This is an existing model demonstrating the combination of thermal and stress analysis.
This problem is using the problem type: AtenaV4 | Transport. It represents a section of a
pipe wall with thickness of 0.23 m and internal diameter of 1 m. Taking advantage of
the symmetry, only a quarter of the whole crossection is modeled. The geometry of the
model is shown Figure 43 and the numerical model is shown in Figure 44. Details about
ATENA-GID interface and associated problem types for ATENA can be found in the
manual [6]. The same mesh size is used for thermal and static analysis. This is however
not a strong requirement. The thermal loading can be exchanged also between models
with totally different meshes.
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Figure 43: Geometry and material properties of the axisymmetrical pipe model.

R/

Figure 44: Numerical model, finite element mesh.

The loading is subdivided in 3 intervals. In the first interval 12 load steps are defined
with boundary conditions as described in Figure 45. In each step the temperature on the
outer surface is increased by 1 °C (see Figure 45). The temperature in the exterior is
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increased up to 37 °C, starting from the initial uniform 25 °C. Each step in this interval
represents 3000 seconds, thus the whole interval covers the period 0-36000 seconds (0-
10 hours).

A

-
Figure 45: Boundary conditions for the interval 1.

In the subsequent interval 2, the temperature at the outer surface is kept constant. This
interval contains 10 steps 2880 seconds long. This means the whole interval spans the
time period from 36000-64800 seconds (10 hours-18 hours).

b

o
Figure 46: Boundary conditions for the interval 2.
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In the last interval 3, the outer surface is cooled back to 25 degrees. This interval
contains 12 steps 1800 seconds long. This means the whole interval spans the time
period from 64800-86400 seconds (18 hours-24 hours).

Ao

-
Figure 47: Boundary conditions for the interval 3.
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Figure 48: Problem data dialog induding the definition of temperature exchange files with stress analysis.

The problem data dialog that is shown in Figure 48 can be opened via the menu item
Data | Problem data. This dialog can be used to define the basic parameters for the
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thermal analysis. The most important fields can be found at the bottom of the Time and
Transport tab, where the names of two files are to be specified. These files are used for
exchanging the temperature fields with the subsequent stress analysis. By default, the
files would be stored in the AtenaTransportCalculation subdirectory of the main
problem directory, inserting “.././” before the names writes them into the
Tutorial. Temperature2D directory.

The ATENA calculation is started from the menu ATENA | ATENA analysis or by

clicking the calculator icon . This will start AtenaWin program which is a
graphical interactive environment for the execution control of ATENA finite element
core module. More details about the usage of this program can be found in the
corresponding ATENA manual [5].

After executing ATENA analysis the following window appears on the user’s computer
(see Figure 49).
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starts the thermal analysis in AtenaWin environment. In order to visualize the
&

dialog that is shown in Figure 50. In this dialog various variables can be selected for

development of the temperature field the button ™ can be selected and this will open a



40

display. = The  temperature fields can be  displayed by  selecting
“CURRENT_PSI_VALUES” | Temper.

Moscow

i @ |lkels %0

1 1 LEGEND:
Convergence criteria 1-4
633831327 o Creometry
4 4972349
E Legend
& LN Post-processor data
@
29981566 2
% 3 = ~fuvailable data General * ~
5 y O ¥ Draw output z b
(& Tz, U 0
DISFLACEMENTS =
EXTERNAL_FORCES Location e 0
INTERNAL FORCES -
NODAL_DEGREES_OF FREEDOM * Global nodes xﬁ: ) [nlln
14880753 NODAL_SETTING z L
NONE ~ © Element nodes W T m 1e010
PARTIAL_EXTERNAL_FORCES ~
@ PERTIAL_INTERMAL FORCES BlEETS M 12
PARTIAL_REACTIONS © Elements [Ps foa
PARTIAL_RESIDUAL_FORCES 2
0_w Mz 10010
0 LA e g REACTIONS M Z le010
2 A % P = REFERENCE_NODAL_CODRDINATES
S H H H RESIDUAL_FORCES
E H g g START_PSLWALUES
g 8 g z
~ ¥ “ = Cancel
i v
Time Apply i )
Filier —

Iter Rel. Humid. Rel. Temper ibs. Humid. lbs. Temper

1 a 1.7 o 3
2 a 9.1e-015 o 5.2e-014

Step: 13 compleced. Elapsed CPU (sec) - this step: 1.672, all steps: 20.857

Job: ATENA, Log end: 24.2.2009 15:43:52

w

Ready |Completed [ Time: 8.6e+004/2  [OVR.

Figure 50: The selection of temperature display in AtenaWin.
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Figure 51: The runtime display of temperature field during the thermal analysis in ATENA.

After the thermal analysis is completed AtenaWin can be closed. All resulting files are
stored in the subdirectory AtenaTransportCalculation of the PipeBTemp.gid directory.
In this subdirectory the following files will exist after the completion of the thermal
analysis:

PipeBTemp.inp ATENA input file created by GiD and used by
AtenaWin
PipeB.00xx Binary result files created by ATENA during the

thermal analysis.
These two files are created in the Tutorial. Temperature2D directory:
PipeB Results.thw Saved temperatures to be used by stress analysis.

PipeB_Geometry.bin Saved geometry to be used for the interpolation of
temperatures in the stress analysis.



42

3.1.3 Stress Analysis

After the thermal analysis is completed AtenaWin can be closed and the stress analysis
can be performed using the calculated thermal fields. A new GiD problem must be
created or the existing problem PipeBStatic.gid can be used. This model defines the
input for stress analysis of the same pipe wall as was used in the thermal analysis.

The geometrical model and boundary conditions are shown in Figure 52.

Figure 52: Geometrical model and boundary conditions for stress analysis.

In order to be able to utilize the thermal fields calculated during the thermal analysis the
appropriate import files must be specified in the problem data dialog that is activated
from the menu Data | Problem data and is shown in Figure 53. This information is
located in the bottom 2 input fields where appropriate file names are specified including
their path.
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Figure 53: Problem data dialog induding the definition of temperature exchange files.

The loading history is specified in a single interval. The interval is divided into 50 load
steps. In each step the temperature difference of 720 seconds from the thermal analysis
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is applied (Figure 54). So the interval spans the period of 10 hours, i.e., it only covers
the heating phase.

The Transport Import switch set to Interval Beginning means the thermal analysis
results are only imported once and the temperature values are interpolated for each
static analysis step. For complex temperature histories, it can be changed to Each Step.
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f v .
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Load Mame |temp load
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v
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[ User Solution Parameters

.......................

PAccepti Close

Figure 54: Interval data for the interval 1.

The stress analysis is again started by selecting the menu item ATENA | ATENA

analysis or the icon. This starts the AtenaWin program. The analysis is started

automatically or by clicking the button. This starts the stress analysis in AtenaWin
environment. In order to visualize the development of the various data fields, the button

= can be selected and this will open a dialog that is shown in Figure 55. In this dialog,
various variables can be selected for display. The contour areas of crack width can be
displayed by selecting Elements | “CRACK ATTRIBUTES” | CODI1. The resulting
computer screen in shown in Figure 56.

The imported temperature values can be displayed as
ELEM_TOTAL TEMPERATURE | TotalTemp. Please note that only the difference
from the reference (initial) temperature is displayed in static analysis.
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Figure 55: Execution of static analysis in AtenaWin and the selection of crack opening display.
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Figure 56: Execution process of stress analysis in AtenaWin showing the crack opening displacements.

After the completion of the analysis the AtenaCalculation subdirectory of
PipeBStatic.gid contains the following files:

PipeBStatic.inp ATENA input file created by GiD and used by
AtenaWin
PipeBStatic.00xx Binary result files created by ATENA during the

stress analysis.

3.1.4 Postprocessing

Postprocessing can be done either in AtenaWin, GiD, or Atena 3D. Normally,
AtenaWin displays the current step that is analysed. After the analysis is finished, the
last step remains in AtenaWin memory and can be visualized and further post-
processed. In case the user wants to post-process results from other load step, the
corresponding step results file is to be opened using the command Application | Restore
FE Model From. The step data file name is “task_name.00xx”, where task name is the
name of the current task as given in the problem data dialog (see Figure 53) and 00xx
represents the load step number which is to be post-processed.
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(Alternatively, the new text window is to be opened using the menu item File | New.
Please note that a text window must be highlighted in order to another text window. If
graphical window is the active one, a new graphical window will be opened. Into the
new text window the following command shall be written:

RESTORE FROM “task _name.00xx”)

3.1.4.1 Postprocessing in GiD

To be able to postprocess the results in GiD, the result quantities must first be made
available by selecting them in the Data | Problem Data | Post Data dialog, see Figure 57.
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Figure 57: Selecting results for postprocessing in GiD.
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The menu command ATENA | GiD Post-processing or the .Q\ icon toggles GiD
between pre- and postprocessing. A warning about non-existent .res file may appear,
then a console windows is started and the results are converted into a format readable by
GiD, see Figure 58. The conversion can take a few minutes depending on model size,
number of load steps, and the number of quantities selected for postprocessing. The
results are stored into the AtenaResults.flavia.res file in the AtenaCalculation
respectively AtenaTransportCalculation directory for static analysis respectively
transport analysis. This file can be opened in GiD by the File | Open command (see
Figure 59).
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Figure 59: Opening results for postprocessing in GiD.

E

The results can be then postprocessed. Figure 60 shows crack width as contour lines,
which can be selected by the menu command View results | Contour lines | CRACK

WIDTH | COD1. The command can also be accessed from the H\%\ icon.
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Figure 60: Displaying crack opening displacement isolines in GiD.

3.1.4.2 Postprocessing in ATENA 3D

The highest user comfort for post-processing is provided by Atena 3D. After executing
ATENA 3D the result file for each increment can be loaded into the program by using
the menu File | Open other | Results by step (*) ... This command activates a dialog that
can be used to load ATENA binary files with results to ATENA 3D postprocessor.
When the user finishes loading the needed result file and closes the dialog, ATENA 3D
postprocessor is automatically started. It should be noted that it is possible to open only
binary result files that come from the same analysis. For further details about post-
processing the user should consult the Part 2-2 of ATENA user’s manual [2].

3.1.5 Conclusions

This tutorial provided a step by step introduction to performing combined thermal and
stress analysis using ATENA software with GiD preprocessor. The tutorial involves an
example of an axisymmetric pipe heated from the outside from 25 to 37°C in 10 hours.

Then the heating remains constant for another 8 hours, and is afterwards cooled back to
25°C in 6 hours.
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The objective of this tutorial is to provide the user with basic understanding of the
program behavior and usage. For more information the user should consult the user’s
manual [2] or contact the program distributor or developer. Our team is ready to answer
your questions and help you to solve your problems.

The theoretical derivations and formulations that are used in the program are described
in the theory manual [1].

Experienced users can also find useful information in the manual for the analysis
module only [4].
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